SHELBYSYSTEMS®

AdvanceYour Knowledge
Webinar Series

Database Cleanup:
Fixing Mistakes in ShelbyFinancials

Welcome
Please take a moment to locate the Zoom Webinar controls.
Feel free to say hello or ask a question using the Q & A feature.



* Since the data related to contributions/giving is in ShelbyNext
Membership, please refer to this previous webinar for great
information about fixing problems and cleaning up that data.

* https://player.vimeo.com/video/691833557
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https://player.vimeo.com/video/691833557

* Pay attention to your financial settings.

* It is best practice for your transaction dates (payroll dates, check
dates) to match the financial period.

* When a mistake is discovered, it is best to fix the mistake in the
application where it was created when possible.

e Attach as much documentation or notes to the entries made,
especially manual journal entries.

* Manage duplicate records regularly. There should only be one record
across all applications.

* Inactivate vendors, employees and customers as necessary.
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When posting transactions in all modules, be aware of 3 dates:
1. Fiscal Year and Period on Ribbon
2. Posting Date when finalizing a batch of transactions.

3. ***Transaction Date. This is an invoice when accruing in AP, AP checks,
Payroll date on checks/ach, and AR invoices and payments.

There are GL settings to force the Posting Date and Ribbon Date to
match; however, there are no safeguards with the transaction dates. If ___
these dates are in a different period, your bank rec could be off with
cash transactions, and your accrual reconciliation from sub-ledgers to Z

N

SASAETIHS

the GL could be out of balance since sub-ledger reports are date
based.

®



* AP Check Date
* AP Invoice Date (Accrual)

*APE
*PRC

ectronic Fund Payments

neck Date

* AR Invoice Date (Accrual)

* AR Payment Date
* BAM Transaction Dates
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Transaction Dates

Fiscal Year: Period: @ March

unt: 1-10110 ACB operating checking

change

Finalize Post |8 Posting Date

% | Post Directly to General Ledger without Editing? €%  Cancel
0 @ |< < 1 of )‘ Excel Worksheet ¥ | Export E{, B
-

General Ledger Input Audit for Accounts Payable Transactions I D t
Company#®: 1 Mame: First Church n V O I C e a e
Fiscal Year Beginning: Period: 9 March Journal: AP B8
Bank Account 1-10110 ACB operating checking
Expense Account #

Vendor I Invoice # Description Amount  Check#s Date

. 1-30-32190 Insurance-property & liability
po Stl N g D a te Church Insurance Co | 25-032018 Property/Liab Ins Gt 54,500.00

1-30-52190 Insurance-property & liability Totals 54,500.00
1-30-60520 Insurance

Chureh Insurance Co I 25-032018 Vehicle Ins Qtr £1,300.00
1-30-60520 Insurance Totals 5$1,300.00
1-0-20110 Accounts payable (GAAP) (55,800,00)
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Home > General Ledger > Posted Journals

Posted Journals Filters

General Ledger > View > Posted Journals

Use the “Projects” filter to select a specific
project to search.

Fund

T
' Department

Account Range

Sub-Account

Journal Types

Journal Number

ﬁ Projects

Description

Date
Amount

Show Summary Journal

|

Q
Q -

Show All

Mot Filtered

Show All

Mission Trip Africa (#15)

Show All

Show All
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GL — Edit Project Code after Posting

>

2| €4 School Scholarships (#2)

1| & School Computer Lab (#1)

Q4 Mission Trip 2013 Guatemala (#3)

CN 33 1-100 41170 Offering-Missions Trips Mission Trips
CN 34 1-100 41170 Offering-Missions Trips Mission Trips
Journal Number: CN 34 l
| s e - -
Date reiod ¢rebraf Select the Magnifiying Glass to edit the
Description Contributions Entries P ro . e Ct C 0 d e
DetaiLs ATTACHMENTS MNoTe J '
Date  Account Structure _Account It can be removed, added, or changed.  Project
1-0 | 10110 ACB operating cf:-el Q
2-210 | 41630 Scholarships
2-210 | 81610 Computer lab School Computer Lab
1-100 | 41150 Offering-Missions Overseas Missions Overseas Q
1-100 | 471170 Offering-Missions Trips Mission Trip Guatemala Youth
1-100 | 41170 Offering-Missions Trips Mission Trips

15/ Q4 Mission Trip Africa (#15)

Mission Trip Africa

Mission Trip Africa

reraseony | conyou |

5189]
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GL — Reverse/Copy Journal Entries

Home > General Ledger > Posted Journals

General Ledger > View > Posted Journals

Use filters to find the journal entry that
needs correcting.

Posted Journals Filters

— Fund

’ Department

Account Range

Sub-Account

ﬂ Journal Types

Journal Number

Projects

Description

ﬁ Date

Amount

Show Summary Journal

Q
Q
Q- Q
Show All v

JE Miscellanegus Journal Entry

Show All v
Mat Filtered
Range r

| Show Al v

1 to
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GL — Reverse/Copy Journal Entries

W

February $0.00 $14,830.29 £0.00 (540,64
Date Journal Account Structure Account Description Project Amao

» IE6 1-10 40110 Offering-Tithes/pledge test (5504

. IEG 1-20 50130 Administration Support test %5(

Journal Mumber: JE &6

Date

Description test

Peried & February

Bl e oy copy ony | roverse s opy

DeTaiLs ATTACHMENTS MNoTe
Date Account Structure  Account Description Project Debit Credit
1-20 | 50130 Administration Support test O. £50.00
1-10 | 40710 Offering-Tithes/pledge test Q £50.00
2 entries £50.00 £50.00
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Statement of Financial
Position

AKA: Balance Sheet

Account

ASSETS h
CURRENT ASSETS *

CASH

10105 Petty cash
10110 ACE operating checking
10140 ACE payroll checking
10180 ACE savings

TOTAL CASH

11110 Accounts rec-registrations

11220 Pensions Receivable

12110 Prepaid expenses

13110 Investments

14110 Inventory-bookstore/coffee house
TOTAL CURRENT ASSETS

5250.00
5795,606.51
(519,515.29)
5430,567.00

51,206,908.22

$2,975.00
50.00
$1,000.00
5260,000.00
51,500.00

$1,472,383.22

FIXED ASS

15110 La}

15140 BY

No header or sub-total
| fOr this section.

15170 FUMOT S T CT o
Total Furn/Building

15210 Vehicles

15910 Accum depreciation

S £, TOR U

$3,951,100.00

528,000.00

(51,350,200.00)
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GL Reports — Correct Groups

Home > General Ledger > Chart of Accounts

Filters

 ExpandAll | | ColiapseAll | [JECIECT QEXELEISIN | Add Sub-Account |

Account Number Usage AccountType  Name
. 3 ./ © 10000 - 19999 Asset ASSETS
General Ledger > Modify > Chart of Accounts $/ © w0 o s et (AR
&/ Q 17110 O Asset Deposits
i/ Q 18110 € Asset Investments-endowment
3 &/ © 10000 - 14995 Asset CURRENT ASSETS
&/ e 11110 0 Asset Accounts rec-registrations
&/ 0 11220 € Asset Pensions Receivable
&/ e 12110 0 Asset Prepaid expenses
&/ Q 13110 0 Asset Investments
&/ 9 14110 0 Asset Inventory-bookstore/coffee house
B <./ © 1000-1093 Asset CASH
/S O 10105 O | Asset Petty cash
/S O 1010 0 Asset ACB operating checking
+ S 0 10140 O Asset ACB payroll checking
./ O 10180 O Asset ACB savings
4 + _/. € 15110 - 15995 Asset FIXED ASSETS
4 &/ € _ 20000 - 39999 Capital LIAB & NET ASSETS
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AP — Copy Invoice

As you have noticed there is a new function in AP > View > Transaction
History. The Copy Invoice function has been added.

Home = Accounts Payable = Transaction Inquiry > Details

& Accrual Basis 1-10110 ACB operating checking

Vendor April Aaron (£2276) Invoice Print on Separate Check?
Terms: none Use ACH?

Apply to credit card (Jpes not apply

Journal AP 3 in January of 2022

Invoice # 3 * Invoice Total $5.00 Check &

* Invoice Date  1/3/2022 e Payment Date [t

Due Date 1/7/2022 m Confirmation # I:I

Detans ATTACHMENTS NoTe

1099 Amount = Status PO,

§1.50
$1.50
51.50
$0.50
$5.00

ount Structure Account

Acce
1-7
1-7
1-7
1-7

[0 I = =
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AP — Undo Invoice (Unpaid Invoice

Company: 1 First Church  Fiscal Year: riod: 10 Aprii  Bank Account: 1-10110 ACB operating checking

Home > Accounts Payable > Transaction Inquiry > Details

« Accrual Basis 1-10110 ACB operating checking

l » ' Vendor Security Co. (#1547) Invoice

Terms: none

Apply to credit card  does not apply *
Journal AP 89 in February of

Invoice # 42-012008 * Invoice Total $133.50 Check #
* Invoice Date s Discount Type Dollar v Payment Dz =

Due Date m Discount $0.

DeraiLs ATTACHMENTS Norte

Account Structure Account Description 1099 Amount
7 130 60410 Security Sy Security Mon, $133.50
1 entries

$133.50

~ Print Invoice Detail Report
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AP — Change 1099 Status on Paid Invoice

Home > Accounts Payable > Transaction Inguiry

Filters

Y

Company | 1 First Church v |

Bank Account  1-10110 ACB operating checking

IMvoice CHECK

Vendor (N0 el O
Inveice #

Invoice Date  Today ¥

%

Invoices \ All (Paid/Unpaid/Selected for Payment)

Adjustments

Manual Checks
Electronic Funds Transfer
Credit Card Charges

o

* Paid
Unpaid
Selected for Payment
I - I Vendor John Smith (#1794) Involce Print on S.epar.ul
Terms: none Use ACH?
Apply to credit card | does not apply *
Journal AP 30 in April of
Imvoice # 1 * Invaice Total 51,000.00 Check #
* Invoice Date =1 Discount Type | Dollar r Payment Date =
Due Date ] Dscount 50 Confirmation ¥
DeTais ATTACHMENTS MoTe CHeck DeTan
Account Structure Aecournt Description Praject 1099 Amount  Status
FaRE- ] 32270 Qutreach  training $1.000.00 P
* Description |training
Praject (=}
1099 Status | Misc. Box 7 - Nonemployee Compensation r 0

* Amount

$1,000.00

oSWALSASAGTIHS



* AP out of balance with GL AP Liability account
* Check invoice dates
Check period posted
Look for manual journals posted to the AP account. Any journals not from AP.
Undo Invoices posted to wrong period.

* Correct 1099 status
* Void checks in correct period
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Payroll > Modify > Employer Information

Home > Payroll > Employer Information

Basic Infarmation

General Ledger Interface

¥ Interface with General Ledger?

Time Off Hours

Category

Account Structure

Account

" Federal Withholding Payable
* Social Security Payable

" Medicare Payable

" Other Taxes Payable

" Non-Cash Clearing Account

1-0
1-0
1-0
1-0
1-0

20530 Federal w/h
20510 Social sec w/h

20520 Medicare w/h

20540 State w/h

20570 Non-cash wash account
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Payroll > Modify > Compensation Information |

Home > Payroll > Compensation Information

Add Ta My Tasks

Filters

v ‘

Add New Compensation

Description

Mon Cash

Auto allowance - accountable plan

Auto allowance - nonaccountable plan

Cell Phone Allowance - Nonaccountable
Corrected State Tax

Housing allowance to purchase or rent a home
Life insurance premiums over $50,000

Salary/Hourly(Reqular Wages)

Social Security tax paid by church

Minister Only FWT

FICA State

County

Local

Distributions
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Home > Payroll > Compensation Information > Update

— Y

%y

* Description Salary/Hourly(Regular Wages)

Box # on W2 | Not in special Box on W2 v

Box 12 Code | Mot applicable

ﬂ

MNon-Cash Compensation?

Pertains to Ministers Only?

Subject to Federal Withho
Subject to Social Security
Subject to State Withhold
Subject to County Withho

Subject to Local Withhold
Subject to Regular Pay Onj

Edit Distribution: Administration Staff

Name Administration Staff

Pay Type Account Structure Account

d Reqular Pay 1-20 50130 Administration Support

" Overtime Pay 1-20 50130 Administration Support

" Doubletime Pay 1-20 50130 Administration Support

' Holiday Pay 1-20 50130 Administration Support

" Other Pay 1-20 50130 Administration Support

" Vacation Pay 1-20 50130 Administration Support

" Sick Pay 1-20 50130 Administration Support

" Bereavemen Pay 1-20 50130 Administration Support

" Unused Pay 1-20 50130 Administration Support

" Social Security 1-20 50640 Payroll Taxes ?
* | Medicare 1-20 50640 Payroll Taxes h
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Description

Box12 FWT FEICA Distributions Home > Payroll > Deduction Information > Update

Cafeteria plan

Charitable Contributions To Church
Elective deferral 403 (b)
Garnishment

Health insurance

OR Workers Comp Program

-
l * Description |Elective deferral 403 (b)
»

Box #onW2 |Box 12

Box 12 Code | E v

Subject to Federal Withholding?

Subject to Social Security and Medicare?
Subject to State Withholding?

Subject to County Withholding?

Subject to Local Withholding?

Edit Distribution: Elective Deferral

* Name |Elective Deferral

Liability Account

Fund 1| Q Church
Department 0| @ Balance Sheet Accounts
* Account # | 20550 - 0| Q Retirerment w/h

Matching Expense Account

* Department 20| Q4 Personnel

Account # | 50650 - 0| Q Retirement-matching
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Payroll — Misclassifying Pastors/Ministers

Home > Payroll > Employee Information > Update

Title * First Name Middle Name * Last Name
IReV. 'I ‘William ‘ ‘ | |Jackson
Employee Information Home Department | Ministers v | Hire Date [6/27/2009 |

Compensations

Deductions

Taxes

ACH Accounts

Time Off Hours

Dhongo

ﬁ

Work Status
Employment Status

Ethnic Group

¥ Minister €

Next Review Date |11/18/2016 | [
Rehire Date |:| e
Minister Date |5/13/2013 | B8

Termination Date |:| f

Employee Information

Compensations

s Add New Compensation

Compensation

Deductions
Taxes > /

ACH Accounts
> 7

Time Off Hours
> 7
Phones > /

Salary/Hourly(Regular Wages)

Housing allowance to purchase or rent a home
Auto allowance - nonaccountable plan

Social Security tax paid by church

Classification

Pastoral Salaries
Pastor Housing

Auto Allowance

LS NI S N

Social Security Allowance
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Payroll — Missing State Tax on Ministers

Employee Information

Compensations

Deductions

Taxes

ACH Accounts

Time Off Hours

Phones

Emails

Addresses

Narmanranhice

Filing Status | Exempt - Do Not Use Tables r

Extra Dollars | $150.00
Extra Percentage 0.00%

o

Pension Plan Qualified

L0 Third Party Sick Pay Withholding

o

Statutory Employee

# of Allowances D

State for Unemployment | Mot Assigned

v

State/County/Local Taxes /
o Add New Tax

Tax Table Description

Status

Exemptions

Extra Dollars

SO0 5C - South Carolina - 0 exemptions

Do Mot Use Tables

]

30.00
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Use Void Check utility:

Use this option if the tax deposit has not been paid. The void check utility changes the 941 report based on
the payroll check date.

Create a Manual Check (negative check):

Create a manual check using the check date of the next payroll. This ensures the Federal tax amounts on the
941 report are correct. Negative amounts have to be entered for compensation, deductions, and taxes on the
manual check.

oS WALSASAGTIHS



Payroll > Utility > Void Checks

Home > Payroll > Void Checks

Select Checks to Void

* Employee Bill Black (#127) Q)

Check # 348 Q
* Check Date 1/21/2018 )
* Amount $2 786 31
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*Use only if tax deposits have not been paid.

*Post to current period.



Payroll — Void Check with Manual Check

Home > Payroll > Manual Checks > Update

Employee lim Anderson (#47) QL ©

Third Party Sick Pay? )

offe Add New Compensation
Distribution

& © Facility Staff
Total Hours: -80.00

ofs Add New Deduction
Deduction

# © Elective Deferral

offe Add New Tax
State/County/Local Taxes

Mo records to display.

o Add To My Tasks

Enter next Payroll Date

Use original check number | Check# 346 Check Date
Amount ject wcC
(51.360.00) Mot Assigned
($1,360.00)
Etderﬂ ?auu
S— * Withholding ($55.73)
($136.00) " Social Security (584 .32)
Total ($136.00) - Medicare ($19.72)
* EIC £0.00
Amount Total Taxes: (5159.77)
Mon-Cash: 20,00
Total
Met: (51.064.23)

Reg T oT Hol Other
-80.00
-80.00 0.00 0.00 0.00 0.00

Enter Negative Amounts for:

1. Compensation
2. Hours

3. Deductions

4. All Taxes

Verify the Net amount (negative)
matches the original net amount.
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* Employee Non-Cash Gift Cards
e Correct Missing State taxes on employee records
* Misclassification of Minister Housing Allowance
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* Reconcile 941 report to GL payroll withholding accounts at least
monthly.

* Make sure Federal Taxable income matches State Taxable
Income... W2 matches W3. Use tax summary on Payroll Register.

* Follow payroll dates, posting date, and period rules.
* Use existing Compensation and Deduction Types —add as a last resort.
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When a transaction that is entered from Bank Account Management is incorrect, it is best to start the fix
from that module. Go to Bank Account Management > Utilities > Reverse/Copy Posted Transactions. Enter
the date of the transaction and it will show the entry.

Home = Bank Account Management = Reverse Copy © ~ddToMyTasks
* Date of Transaction |4/26/2022 e
Description Total Deposits Total Charges
> D B Interest deposit §15.03 $0.00
AR El FM Page size: | 100 ™| 1 items in 1 pages

Home = Bank Account Management = Reverse Copy

* Date of Transaction by

Description

Click the Reverse or Copy icon and the appropriate entry will
be entered to the Manage > Unposed Transaction screen.

> D Ijj Interest deposit

ey e

M4/ )2 )p) Pagesize | 100 |
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Use “Transactions” for Misc. Deposits
Use AP — “Electronic Fund Transfer” for cash withdrawals or debit card transactions.
Avoid manual journal entries of cash if possible.

Multiple Funds One Bank Account — use journal entries to transfer “cash” between funds.
This is an internal transfer and not bank transfer. Uncheck "Send Entry to Bank Account
Management".

If possible, reconcile on a weekly basis to help with online deposits.
Use Bank Statement file import to reconcile.
Run detail ledger on cash account. Verify all manual journal entries that impact cash.

Look for items posted in incorrect period.
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BAM — Use View (Inquiry

Home > Bank Account Management > All Items
l Filters

o Add New ttem < —
Item® Type Date Payee/Description Amount Statemd

S © 90001 Deposit Contributions deposit £15,185.00

_J‘" £ 901004 Deposit Contributions deposit £267.00

S © 905001 Deposit Contributions deposit $13,950.00
907001 Deposit Deposit (£209) CK8 £850.00

_f‘ e 91200 Deposit Contributions deposit £125,959.00
801005 Withdrawal Withdrawal (#1508) CK 28 ($7.500.00)
901011 Deposit Contributions deposit CM 12 $11,155.00
2 Check Internet Provider Co. D1 ($230.00)
3 Check Light - Gas Co. cD1 ($2,050.00)
4 Check Mr Bugs Pest Control D1 ($65.00)
5 Check Security Co. cD1 ($133.50)
6 Check Water - Sewer Co, D1 ($450.00)
801004 Withdrawal Concern Health Care (#1565) CK 20 (54,800.00)
901017 Deposit Contributions deposit CM 38 £1,000.00
901006 Deposit Contributions deposit CNT $20,450.00
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BAM — Reconcile to Bank Statement

ReconciLiATION MNotes ATTACHMENTS
Item # | Amount S0.00 Import Electronic Bank Statement
Checks/Voids/Withdrawals/EFTs
(| Item & Amount Date Description
o ($65.00) | Mr Bugs Pest Control
o ($133.500 l Security Co.
[ I

o ($4,800.00) Concern Health Care (#1565)

' | | I
& ($480.00) Campus Crusade
o 101 (5200.00) Freedom Im Christ
o 102 (%1,350.000 Meighborhood Ministries
U 103 ($150,00) Salvation Army -

Statement date ' =

Opening Ballm:el £0.00

Met Activity ($3,178.50)

Calculated Ending Ballm:el ($3,178.50)

Statement Ending Balance.  $500,000.00/

Out of Balance By £503,178.50
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BAM — Reconcile to General Ledger

Deposits

Item #

205001

912018
912017

912016

902003

$200.00

»
$2.500.00 |
-
$50.00
$20,450.00

Date v+  Description

Deposit (#299)
{
Account Receivable Payments

r
Weekday School Tuitio

:
| Misc. Deposit

Contributions deposit -

Reconcile to General Ledger

Statement Period v

General Ledger Balance |  $826,469 61

Outstanding Items I $812,412.55

General Ledger Calculated Ending Balance|  $14,057.06

General Ledger Out of Balance By |

Reconciled Items from after the Statement Period l
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* If you find that Bank Reconciliation and General Ledger do not agree,
follow the checklist below for actions you may have skipped.
* |s the Statement Ending Date correct?
* Check to see if the Ending Balance was entered correctly.

e Are you missing any interest, fees? Run a Bank Reconciliation report on the
cleared items by Deposits, Withdrawals, and Checks. Do the separate
balances match to the bank statement for those same items?

* Are there any odd dates such as 2002 or 21207
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Look for unposted journal entries in the Journal Entries area of General Ledger (do
not forget to set the Users criteria field to All Users).

If your bank statement reconciles to zero, but your General Ledger balance is off,
compare your Detail Ledger and the Bank Reconciliation report. Set the criteria to
All Items and sort by Journal #. You can add the Journal # under the options tab to
the report. Run using the statement begin and end dates. Compare the two
reports. What is different?

Did someone uncheck the “Send Entry to Bank Account Management” when posting
a journal entry related to a cash account? If you see the entry in the General Ledger
but not in Bank Account Management, create an Outstanding Item for the

missing transaction.

Look for any manually entered outstanding items that haven’t cleared. If that’s the
difference, delete it.

Are there old withdrawals or deposits still outstanding? Those are errors and need
to be corrected.
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The

1 Rule in Bank Reconciliation is...

The Bank Statement Ending Balance
+

(Good) Outstanding Items

= General Ledger Balance
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Where can | watch this video again?

WatCh or Register to attend Advance Your Knowledge Webinar Series
Webinars

@ Community.Shelbysystems.com T —

Events, and Holiday preparations)

(Central Time)

Click on a Title to Watch NOW Presented

Now Including Slides to Download

Things ¥ d Be
10/20/2021 Slides
for eFiling Your W2s and 1039
Mazking, Tracking, and Reporting Budgsts 09/22/2021 m
e Driv 1
< o 08/11/2021 | Siides |

A Quiick Lock at Best Practices for Groups 0742212031
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http://community.shelbysystems.com/

Tracking Mission Trips in Non-Financials

Date: 5/25/22
Time: 3pm E/2pm C/12pm P
Led by: Ben Lane, Senior Staff Trainer
with Bill Ballou (Training Manager) moderating

See how you can offer registrations, track giving, send out mass updates, and generally keep up with
your mission teams using the tools available in Non-Financials (using giving, forms, mass contract,
workflows, and groups). Join consultant Ben Lane for this totally free webinar as he walks us
through some great processes to keep your mission team informed, supported, and organized.
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Your Knowledge

Virtual Workshops

Virtual Workshops for Spring & Summer!!!!

Click Here to Reqgister

Now Availablel!l!!
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https://www.shelbysystems.com/learn/training/shelby-virtual-training-workshops
https://store.shelbysystems.com/workshops/

Resources

Contact links that are provided in this webinar are unique to Shelby Systems. If you
are watching this and use one of our sister companies Giving or ChMS products,
please connect with your Success Representatives or Support Team.

Q Training@shelbyinc.com MPower University

MinistryOne
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https://training.mpoweruniv.com/
https://help.ministrybrands.com/en/articles/4589086-ministryone-creating-your-church-app

